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A letter to the Desk of Editor 
Hello friends! 

SketchUp ur space has completed a long journey for the sake of SketchUp lovers and a 
long way is to be covered. Our task becomes very difficult day by day. We have to make 
our magazine more attractive and more informative. Keeping this in mind we have just 
launched another cool issue of SketchUp-ur-space. 

The theme of the current issue is based on “SketchUp Shortcuts”. The team of SketchUp-
ur-space has written an interesting cover story focusing on some useful tricks to enhance 
the speed of your 3D drawing process. The readers will come to know some useful 
shortcut keys for SketchUp. 

In interview section, we have presented an exclusive interview with Paul Lee, Virtual 
Architect & Managing Director at Viewsion Virtual Environments. In this interview Mr. Lee 
has explained his passion for SketchUp and how it helps him to become a successful 
architecture. 

In article section, Damian Keeley, renowned architect and 3D visualize from UK, has 
written a informative article focusing on step by step process to create a 3d model of a 
wheel with SketchUp. 

In tutorial category, Andrew Alexander, a promising CAD Designer from Vancouver, BC 
area, provides an useful tutorial about making flowing surfaces without using plugins. 

There will be another exclusive tutorial on how to render night scene with SketchUp and 
vray plugin. 

In blog category, Jim Leggit, the well known architect, urban planner and professional 
illustrator, has shown “how to a turn a hand drawing into a night scene applying 
Photoshop and a couple of very quick digital modifications”. 

In news and plugin categories there will updates on newly launched SketchUp plugins and 
other 3D texture tools like SU Solid, Raylectron SketchyMesh, Raylectron Textures 
Exporter, PixPlant, etc. useful for 3D modeling. 

Hope our readers will enjoy this issue as usual. Please provide your valuable feedbacks for 
more improvements of our magazine. 

 

Hope our readers will like this publication of SketchUp ur Space. We will welcome some helpful feedback 
from our readers. Please send me your suggestions at rajib@SketchUp-ur-space.com. 

 

Best Wishes 
Rajib Dey 

Editor 
Happy Reading! 

mailto:rajib@sketchup-ur-space.com�
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Interview with Paul Lee - Virtual Architect & 
Managing Director at Viewsion Virtual Environments 
Please make a brief introduction of yourself to our readers. 

I am passionate about creativity and have always enjoyed art and science. I get bored 
quickly if I'm not using my brain and expanding my knowledge so it was very natural that 
I would end up working for myself. I have mastered the art of drawing and painting at a 
young age and was tempted to go to art college. Luckily I didn't do that because college 
generally makes you dislike what you already liked so I went to architecture school. 
Somehow though, I still love architecture. 

When do you first discover SketchUp & start to utilize it in your project? 

In 2006 I was setting up my architecture business- Aspire Architecture- (which is currently 
undergoing a revamp) and I was using CAD. The amount of work it took to create the 
required information was so great that I knew that 2D information was not sufficient or 
even viable for doing my work. I looked at a few 3D packages and an architect friend of 
mine mentioned SketchUp. She said it was pretty cool but I had no idea how cool it was 
going to be. Once I started using it I was hooked. Game over. 

How did you get inspired to become a virtual architect? 

Since graduating from architecture school at the Dublin Institute of Technology in 1996 I 
have gravitated towards using technology as a way of solving the problems that exist 
within the business of construction. That is why SketchUp, which is the most direct system 
I know of for bringing a concept into digital form was very attractive to me and I decided 
to make the leap from CAD to SketchUp in 2006 and then to form Viewsion training centre 
in 2008 with a business partner- Alan O'Brien who is an IT professional. 

Can you differentiate SketchUp as a most simplified tool in comparison with 
other 3D modeling tools? 

SketchUp is a fast modeling system. I have heard many competitors make this point- not 
just SketchUp enthusiasts. It is also very adaptable and can be used in many different 
industries from architecture/ construction/ engineering to product design and virtual movie 
sets. The range of applications is virtually endless (pardon the pun) 

How do you evaluate SketchUp? 

The mistake that many people make is that because SketchUp is so fast, that they 
imagine that it's not so "deep". This is unfortunate, because SketchUp can effectively 
replace CAD (as a 2D paradigm) as it exports dwg and dxf as well as many other filetypes. 
My point is that there is no excuse for generating information in 2D anymore. Now that 3D 
is easy and accessible and can deliver the 2D information, it's not very clever to keep 
doing the 2D thing. In addition, SketchUp has strong Building Information Modeling (BIM) 
credentials, as it does accurate 3D, 4D (construction sequencing), 5D (cost analysis) 6D 
(Facilities Management Model) and 7D (energy analysis). It also does Construction 
Documents as detailed in my 
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Please point some cons about SketchUp? 

One thing that really bugs me about SketchUp is there are no built-in "Mirror" or "Fillet" 
commands. I know there are plugins available for these function but it does make 
SketchUp look silly to CAD users that it isn't a standard feature. 

Another point is that because SketchUp is effectively a replacement for 2D CAD, they are 
afraid to market it as such. I can't understand this, and have been saying it for years. 

You also work as teacher cum trainer for SketchUp. Please share your experience 
with our readers. 

I started teaching in 2001 in St. John's Central College, Cork City, Ireland. I taught 
architectural drafting, tech drawing, and CAD. I wrote a course to show how CAD should 
be used in an office environment because there was no effective course for this and 
standard CAD courses were academic in nature and did not prepare people for the 
workplace. When I discovered SketchUp and realised it's potential, 2D CAD was over for 
me. 

In 2008 I started Viewsion Virtual Environments with Alan O'Brien who is an IT consultant. 

What upgradations should be included in SketchUp for architectural modeling in 
near future? 

I believe that SketchUp should have better 2D tools. The course I wrote illustrates a very 
effective workflow for using SU Pro for this purpose and as such it is a very good set of 
exercises in their own right. However, SketchUp should have some effective tools to 
automate this process. 

Cost analysis is an extremely important aspect for SketchUp that should be capitalised 
upon. 

I would also like to see effective export options for the IFC format. 

The SketchUp has been acquired by Trimble but we do not find significant 
developments for launching new plugins for SketchUp. What are your opinions? 

To be honest I don't know how the transition has affected the development of plugins. I 
hope that Trimble takes this aspect seriously and engages with programmers to keep 
SketchUp fluid, open and exciting. Enjoyability is a major factor that many of the software 
vendors ignore- I would say "Ignore enjoyability of software at your peril!" as creativity is 
becoming more important as a factor. 

 

What suggestions do you want to provide for budding architects & newbie 
SketchUp users? 

I would say to architects- don't fall into the trap of thinking that you are being prepared to 
work in an office for someone else and just designing buildings. Think outside of the 
traditional career structures- Even construction itself is going to become more like product 
design and virtual modeling is going to increase in importance. Video and Tablet interfaces 
are extremely important to understand and to learn how to manipulate. Learn to use the 
tools that suit the task you are engaging in, and don't get "snobby" about software- That 
attitude will turn you into a dinosaur pretty fast! 
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Did you find our magazine useful for SketchUp users and why? 

SketchUp ur Space has a lot of resources for those interested in the platform. I like the 
emphasis on interviews and it's important to have focus on new and important 
developments for the SketchUp community. 

Construction Documents using SketchUp Pro - Publication from Viewsion 

 

  

http://www.viewsion.ie/#!publications�
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Apply SketchUp shortcuts to increase the speed of 3D 
modeling process 

SketchUp is a very helpful tool which can easily generate 2d and 3D drawings. The 
software is very popular among architects, civil engineers, 3d makers, freelancers, game 
designers, production designers etc. due to its user-friendly interfaces. 

SketchUp contains a wide range of shortcut keys which will provide great assistance to 
SketchUp professionals and experts to accelerate their drawing procedure. The shortcuts 
will help you to save huge amount time while creating a model. 

SketchUp contains several preset keyboard shortcuts but one can make its own custom 
keyboard shortcuts. It will surely help users to make a best possible interface to fit the 
way you utilize SketchUp. The users will be able to make its own shortcuts and in order to 
do that the users have to visit Window-Preferences-Shortcuts. From the scroll menu, 
chooses a few actions and allocate a keyboard shortcut to active/toggle that action. Don’t 
choose a shortcut which exists with another action before now as it will show you an error 
message. 

These shortcuts are assigned to the mouse and to the keyboard. Trimble has launched a 
reference card which contains the huge lists of shortcut keys. This reference card is 
related with SketchUp 8. 
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Given below some important keyboard shortcuts compatible with SketchUp 7 & 8. The 
shortcuts will facilitate users to generate models quickly and efficiently. 

Shortcut Keys for SketchUp 8 

Name of keystroke Application SketchUp Version 
A Arc 8 
B Paint Bucket 8 
C Circle 8 
E Eraser 8 
L Line 8 
M Move 8 
O Offset 8 
P Push/Pull 8 
Q Rotate 8 
R Rectangle 8 
S Scale 8 
Select Spacebar 8 
Zoom Extent Shift+Z 8 
Shortcut Keys for SketchUp 7 

 



 

8 
 

Mouse also plays an important role for applying shortcut tricks. If you press left button of 
the mouse it will help you to select an object easily. Apply right button of the mouse after 
choosing a geometry and it will unveil a context menu from where the users can pick up a 
wide array of functions to accomplish any task. 

Middle button alias wheel is utilized to zoom in and zoom out. Press it and drag, the user 
will be able to orbit just about the model. Push the shift key, click on the wheel and drag 
your mouse to apply the pan tool. Double click to re-center the view. 

If you want to view the detailed lists of shortcuts, visit the menu bar and select “Tools” 
bar. You will see that all shortcuts are assigned with capital letters. 

 

In order to view the shortcut control panel, choose window on the Menu Tab. Go to 
preference and click on it. Now a dialogue box will arrive, here choose shortcuts. To load , 
click on the import button and select preference.dat. 
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Now apply the filter key to search for the Protractor tool. Select the key which you would 
like to set as your shortcut key and press enter. 

Get on that small “+” icon on the right and selected shortcut will be assigned. Click on 
“OK” to close the dialog box. 

To get accustomed with the shortcut keys, the user has to make continuous exercises. 
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Reinventing the wheel 
Measuring a wheel as a starting point, in this case a wheel from a radio controlled model 
Tamiya Madcap. 

Basic measurements such as diameter and central hex size were taken, as were wall 
thicknesses to use as a rough guide to start the modelling. 

 

I began working in a CAD drawing programme, to set out the wheel section, and tyre 
diameters. 

I chose not to model this wheel in Vectorworks as it was a programme I was comfortable 
working in 2D in, but I just couldn’t get the hang of 3D in this release of Vectorworks. 
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I exported the model as a .dwg and imported it into Sketchup 8 Pro. 

You will need a Pro version to import and export .dwg files. 
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Bringing in the .dwg, I was pleased to see that Sketchup had recognised the groups and 
blocks from the original drawing. This makes life much simpler to organise the model. 

Everything is drawn Layer 0, and then groups and components are assigned to other 
layers as needed to turn sections of the model on and off when in the working space. 

 

I imported the dwg and then arranged the groups so that I could perform a ‘follow me’ 
command based on the wheel rim section and the circumference of the wheel. 

I also modelled the hub at this point and inserted it into the same group as the rim, as I 
wanted it to be exactly central to the circumference of the rim, this is important for when 
the wheel is made, as it should rotate in a true rotation. 
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I tried various ways of modelling the spokes, but just couldn’t get the sophistication of 
profile as I wanted at first… 

If at first you don’t succeed… 

And I did try quite a few different approaches until I got what I wanted! 

 

Like I say, I tried quite a few different approaches! 

Intersect with model, and push pull, and most of all rotate copies! I learned quite a few 
new commands doing this model, fortunately there is plenty of help 
from www.sketchucation.com 

http://www.sketchup-ur-space.com/2013/march/www.sketchucation.com�
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I settled on a fairly flat spoke in the end, choosing to express definition through sculpting 
a flat disc. 

I split the disk into three segments, making a component of each, and reproducing it. 

In this way, I reduced the work required to create the spokes by one third! 
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Lining up the rim and the hub and the spokes was simple enough after a few carefully 
placed guide lines were laid down 
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Reflecting on what other models had been discarded on the way to the final model, I 
realised that nothing is ever wasted. Lessons and tricks were learned, that would be used 
elsewhere in the model, and in future models. 

 

With the model setup in place I wondered how I could export it as a perfect .stl file, which 
does not contain any internal wall sections, or random faces. 

The terminology of an STL file that can be printed is ‘manifold’and means the model is of a 
sufficiently high quality to be 3D printed or Milled on a CNC machine. 
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As a break from wondering just how to export a complex, and quite messy model as a 
perfect manifold STL file I took some time out to play with some photo renders to see 
what the wheel looked like with accurate reflective materialsassigned to it. 

 



 

18 
 

I liked what I saw, and pursued the initial renderings with a pro version of Maxwell render 
for Sketchup, which whilst not providing the quickest turnaround in rendering time, is 
certainly an affordable and professional level rendering package plugin that works within 
Sketchup, no messy imports or exports needed! 

 

I had some fun with rendering, indeed extending the separate components within the 
model, as an exploded diagram. 
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Back in Sketchup I had read about a plug in called CAD SPAN that would promise the 
ability to ‘shrinkwrap’ any existing geometry in a single layer of faces, thus the manifold 
problem had a potential answer! 

No more messy geometry! 

 

Part of making a manifold shell is that the faces are all orientated the correct way… 

The difference in colours here indicate that all is not well with the model and that some 
face need to be reversed. 
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Back to the same Sketchup model that had been used for photo rendering was now being 
cleaned up to allow 3D printing… 

 

Cleaning up did eventually happen after much investigation of hidden geometry within the 
model. 
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The CADSpan Plug in was very useful for showing various problem parts of the model! 

Missing faces, etc. would all have to be fixed before a shrink wrap could be made… 
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Following exporting from the Sketchup CADSpan plugin, that works within Sketchup, the 
model was checked for conformity in a free programme called Meshlab… its really quite 
useful, in case you haven't got the shrink wrapping just right yet. I didn’t get it right for 
half a dozen goes! 

 

Once the wheel was confirmed to be ‘Manifold’ I Uploaded it to a MakerBot, which is a 
basic 3D printer, to test to see whether the process had in fact worked… 
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The model had in fact been accepted as a piece of digital code, and as plastic tubing was 
melted and squeezed through a nozzle over a moving print platform the wheel emerged 
over the next 30 minutes 

 



 

24 
 

Whilst this model does not have the resolution of a high quality and expensive powder 3D 
printer, and suffers from melted strings, it does prove that the process is complete and 
works. The same model, as a digital object could be uploaded to Shapeways or other 
printing bureau’s in a variety of precise and exotic materials. 

 

Returning to the same model I looked again at optional colour profiles that could be 
printed by a 3D powder printer 
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All in all the process was successful, even if the quality of the final print was a little lower 
than can be achieved commercially. 

It is important not to be discouraged to easily, and remember what has been achieved 
through the process. 
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Creating a Night Scene from a Daytime Drawing 
 

 

This a a simple method of taking a hand drawing and turning it into a night scene using 
Photoshop and a couple of very quick digital modifications. I’ve always struggled to simulate 
a night time scene with traditional hand drawings. I found it nearly impossible to render the 
evening illumination from storefronts and the dramatic contrast between dark shadows and 
lighted spaces....until now! 

A quick and effective way of creating the wonderful quality of evening light is to layer over 
your hand drawing with a transparent black overlay in Photoshop, then erase portions of it 
where the light occurs. I created this sketch for a recent studioINSITE project and turned 
my original hand drawing of a daytime scene into the night scene for the title slide in a 
PowerPoint presentation. My step-by-step process is explained below: 

 

Initial Overlay and Trace Drawing 

http://www.studio-insite.com/�
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Step 1: Digital Photograph

 

. I composed this photo specifically to generate a hand 
drawing showing what a temporary widening of the sidewalk might look like if the parallel 
parking was replaced with an outdoor seating area constructed just for the summer months. 

Step 2-3: Overlay and Trace Hand Drawing

 

. I printed the photo on 11”x17” paper and 
blocked out the scene with red pencil on tracing paper. On a second sheet of tracing paper, 
I sketched the scene with a Pentel Sign Pen. Notice that my linework has no tone or texture 
- which was added later in the coloring step. 

Step 4: Final Marker and Pencil Color. After making a record scan (300dpi) of my line 
drawing, I colored the scene with Chartpak AD markers and Prismacolor pencils. Colored 
pencils were great tool for developing the different gradations in the sky, adding texture to 
the ground plane and delineating the brick on building facades. I scanned the final artwork 
at 300dpi and saved a jpeg. 

Digital Modification in Photoshop 
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Step 5-6: Photoshop Overlay

 

. I created a new layer in Photoshop that was colored black 
and then given a 50% transparency. I selected the “multiply” blending mode and then 
picked a white paintbrush to begin “digital painting” the illuminated portions of the street 
scene. The paint brush I used had a soft edge to simulate the filtered light. 

Step 7: Spot Digital Painting. This entire process did not require any special hardware 
other than my laptop and mouse. As you can see in this interim step, by painting with the 
color white, I basically removed the gray color where I wanted to emphasize where the light 
was being sourced from the storefronts, street lights and signage. 
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Step 8: Final Digital Effects. I completed the digital modifications in less than ten 
minutes, saved a .psd file and an extra jpeg of the scene. I slightly darkened the jpeg to 
increase the illusion of the evening scene. This technique was a great shortcut for 
converting a day time scene into an evening scene. If needed, you could always add some 
yellow and orange colors to the scene to reinforce the color of storefront lighting. Try this 
method with one of your drawings and see if you can achieve the same results! 

Read More.... 

 

  

http://jimleggitt.typepad.com/jim-leggitt-drawing-shortcuts/2013/02/creating-a-night-scene-from-a-daytime-hand-drawing.html�
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Flowing surfaces without plugins! 
If you want to make a curved surface in SketchUp, in can be a difficult process to get it 
just the way that you want it. You can draw it manually line by line, by this is very time 
consuming and it is very hard to make it look good and smooth. There are plugins that 
make this much easier, but I’ve discovered a way of getting smooth rounded shapes just 
using basic SketchUp. 

There is a method that I call “Pull and Scale” that is an easy way to make almost anything 
that you can think of. Here are some examples of models that I’ve made using this 
method. 

 

For this tutorial, I will show making the front part of this space shuttle: 



 

31 
 

 

The easiest way to start is with images or line drawings of the front, side and top. These 
are easy to find online for almost anything you want to make. 

 

Of course, reference drawings aren’t necessary for this procedure, but I like having them 
to make sure that the model I draw is in scale. I typically trace over the drawing to get 
the overall shapes that I want to work with. Also, since the shuttle is symmetrical left and 
right, I make trace half shapes. This way you can mirror it over in the end and your model 
stay perfectly symmetrical. 

So choose the starting method that you like best. For this tutorial I setup the images as 
follows, and trace over them. Notice the only one of the shapes is filled in. This is the face 
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that we’ll be working with. The face of the others has been deleted so it’s just linework. 
This makes it easier to see what you are doing. Make the line work groups, so you don’t 
accidentally change the shape of it while modeling. If also helps to lock the object so you 
can’t move it at all. 

 

 

Using the Pull tool, pull the face out a bit. The smaller you pull it, the smoother the final 
shape will be. For a more complicated shape, or for parts that are much more curved, use 
a very small pull distance. For this relatively simple shape, I can use a larger distance. 
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Select the new face on the end and using the Scale tool to change its shape. Be sure to 
not scale the shape using the grips in on the left side of the shape. This will make an 
uneven surface to mirror the shape in the end. This is where the reference line drawing 
come in handy. You can snap to them to make sure that you are getting the correct 
shape. 

 

Continue this procedure for the entire shape. Notice that for the front tip of the shuttle, I 
used a smaller pull distance because I wanted a smoother nose. 
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Highlight the entire model and go to Window -> Soften Edges, and set the slider to around 
45 degrees. This will makes the shape look much smoother. 

 

When the shape is complete, delete in inner and back faces and lines, so you are left with 
the shell only. 
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Now using the move tool select the model and press Ctrl to make a copy. Place the copy 
next to the original shape. 

 

Right click on the new shape and choose “Flip Along… -> Component’s Red” (or Green 
depending on how your model is oriented) 
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When you move the shapes together, the edges to fit perfectly. 

If you see any of the following on your model, it means that at some point in the process 
you either scaled incorrectly, or you accidentally changes one half and not the other. 

 

Once done correctly, you should see this: 



 

37 
 

 

Select the whole model again, and open up the Soften Edges dialog again, and smooth the 
new edge. For this, make sure the “Soften coplanar” option is selected 

The basic shape is done! 

 

Now you can further add things like windows, by tracing the line drawings, extruding and 
moving the shapes so they intersect the shuttle at the correct places. Like this: 
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Right click on the hull and choose “Intersect face… -> With model”. Now when you delete 
the shapes you just created, you will be left with the shapes “stamped” onto the curved 
hull. 

From here you can use the paint bucket to colour the windows separately from the rest of 
the cockpit. Using this method, you can complete the rest of the cockpit. I’ve developed 
this one a bit further: 
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Now that you know this method, the only limit is your imagination! 

Raylectron Textures Exporter... 

Export all the textures from a model to a directory. As-is, or all as png, jpg or bmp. 

http://raylectron.com/Raylectron_Textures_Exporter_Setup_Win32.exe 

 

  

http://raylectron.com/Raylectron_Textures_Exporter_Setup_Win32.exe�
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Night scene render with Google SketchUp 
Hello everybody, today we will render night scene with Google SketchUp and vray plugin. 

First you need a simple lantern like below. You can draw it from circle with help of 
Pushh/Pull command 

 

First of all you need to install 

 

and open vray toolbar. 

http://www.sketchupfans.com/sketchup-plugins/sketchup-rendering-software�
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Open Material Editor on toolbar that "M" letter icon. 

so what the material is : think it like wallpaper you can cover something. except it 
contains some effects like transparency like plastic bags. some extra lightning like 
fluorescent lamps. 

 

Older version of V-ray material editor looks like this: you can add new material by right 
clicking the "Scene materials" label (picture below) 

 



 

42 
 

Newer version of V-ray it looks like this picture below ( VRay for SketchUp 1.48.66) Both 
works with same idea. just right click the scene materials. 

 

After you create material, click the Diffuse for change surface color. You can see the 
results on sphere by clicking Preview. 
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To apply new material to the lantern: choose the glass section of lantern then right click 
the new material you just created, then choose apply material to selection. 
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Other versions of vray it named: apply material to objects. 

 

We can now check out our scene: just click the R icon on toolbar, R for Render . ( Again, 
this is newer version of v-ray, look how icon colors differs ) 

 

Here is simple result: 
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Scene looks good but we need night scene and light up that lantern. 

First disable the sunlight: Open the "Window > Shadows" menu above, change the hour 
to "03:00

 

" that means midnight 

 

Lets fire that lantern: 

Right click the material name and create "Emissive" layer. that give us fluorescent or neon 
lamp effect. 
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Now change the color and intensity of Emissive layer. I gave 100 to the intensity. (You can 
also change the light setting from Vray Options window, Change camera shutter between 
100-300) And you completed neon lamp. 

 

But remember one last thing (damn, it took my 1 hour to resolve what, SketchUp does not 
show face normals). 

If you see black surface like picture below: right click the surface and say "Reverse faces" 
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Render complete. you made simple lamp. and so nice with v-ray plugin. 

 

Completed sketchup scene: Download 

Source: http://www.sketchupfans.com/advanced-sketchup-tutorials/night-scene-render-
with-google-sketchup/zkaydet/ 

http://www.sketchupfans.com/ders/49/lovelylantern.zip�
http://www.sketchupfans.com/advanced-sketchup-tutorials/night-scene-render-with-google-sketchup/zkaydet/�
http://www.sketchupfans.com/advanced-sketchup-tutorials/night-scene-render-with-google-sketchup/zkaydet/�
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Raylectron SketchyMesh 
SketchyMesh is an easy terrain and shape builder. It is based on the formula z=f(x,y) for a grid where you 
enter your own ruby formula using x and y. Create terrain and shapes from a grid using formulas in the 
form of z=f(x,y). 

You don't need to know math, just modify the ones that comes with the plugin and see what it does. 
There is an Undo button to easily undo the mesh, so you can change the formula quickly on every turn. 
You can go the "View" menu and turn on "Hidden Geometry". 
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You can download it from http://Raylectron.com 

Downloadable link:

it is free with source code but is (c)2012 SoftByte Labs 
Inc. 

All in Ruby with source code. 

 http://raylectron.com/Raylectron_SketchyMesh_Setup.exe 

John Friesen - SoftByte Laboratory, Inc. 

http://raylectron.com/�
http://raylectron.com/Raylectron_SketchyMesh_Setup.exe�
http://raylectron.com/�
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3D Modeling With Daniel Tal and Google SketchUp 
Daniel and Ambit-3D create virtual 3 dimensional site plan models for architects, 
landscape architects and developers working in both the private and public sector. He has 
become so proficient with Google SketchUp that he now teaches other design 
professionals how to use this incredibly powerful tool for their own presentations. Best of 
all Google SketchUp is a free download 

On todays show Daniel will discuss what Google SketchUp is and how landscape 
professionals can use it's powerful tools to create their own 3-D models in just a few days 
to help them design, sell and build work. 

Check out some of his work for yourself at http://www.ambit-3d.com/Renderings.html 

 

  

http://www.ambit-3d.com/Renderings.html�
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A new way to great 3D textures! 
PixPlant 2 is a smart 3D texturing tool that creates high quality normal, displacement, 
specular maps and seamless textures from plain photos. 

Based on photos, PixPlant adds an unlimited choice of realistic materials for your projects: 
pick an interesting photo, run PixPlant and get a perfect seamless 3D texture. 

3D textures, automagically - Try PixPlant now! 

PixPlant 2 Benefits 

Save a Lot of Texturing Time: PixPlant reduces to almost zero the time and work of 
preparing tiling 3D textures and backgrounds. 

Diversify your Textures: Quickly turn photos into usable 3D textures, adding realism, 
variety and value to your projects. 

• Quickly create unique seamless 3D textures, horizontally and/or vertically tiled. 

Benefits for 3D visualization, architecture and games: 

• Based on real-life photos, PixPlant generates realistic textures without the 
complication of procedural texture generation tools. 

• Generate and fine tune normal, displacement and specular maps for highly realistic 
3D texturing. 

F

• A creative "image alchemy" tool: create high resolution, high quality images with the 
same characteristics as the photo sources. 

or graphics and multimedia design: 

• Easily create unique images that can be used as backgrounds, patterns or brushes. 

• Expand or complete existing images by adding detail from themselves or from other 
images. 

• Create normal, displacement and specular maps ready to be used in 3D modelling 
applications. 

PixPlant 2 includes the following features: 

• Fine tune 3D textures with an interactive parallax mapped 3D preview. 

• Create textures from almost any photo, thanks to advanced straightening and seed 
pattern controls. 

• Highly automated with most textures created in 1-4 clicks. And high performance 
with usually a few seconds per texture. 

• Generate complete images or refine and expand existing ones. Out-select parts of 
the seed image for fine grain control. 

• Carefully designed easy-to-use interface, now also available in 64 bits as a 
standalone application and as a plug-in for Photoshop and compatible applications. 

To see PixPlant screenshots and some generated images please visit the Examples area. 

http://www.pixplant.com/download.php�
http://www.pixplant.com/gallery.php�
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DAVID Structured Light Scanner 
The new DAVID-SLS-1 scanner employs the innovative Structured Light technology, which 
allows precise 3D scanning in a matter of seconds. The scanner is mobile and can be 
placed easily in front of the surface to be scanned. A single click in the well-proven DAVID 
software starts the scan - and a few seconds later the digitized 3D model shows up on 
your screen! 

This way you can subsequently scan all sides of the object, and finally combine them to a 
closed 360° model. The modular hardware setup allows a flexible adaptation to your 
object - any size from coin to couch is possible! 

The results can be exported into common 3D file formats (OBJ, STL, PLY) and processed in 
other applications, e.g. for rapid prototyping, inspection, product presentations, 
archeology and cultural heritage, works of art, computer animations, video games... The 
limits are set only by your imagination! 

User Manual: The Getting Started Guide is available in English and German. A more 
detailed User Manual can be found here. 

For more information, please visit: www.david-laserscanner.com 

• Industrial camera with focusable lens 

Contents of package 

• Video projector with special lens for large focus range 

• USB drive with DAVID-Laserscanner Pro Edition 3 software (licensed) 

• Aluminium mounting rack with flexible configuration options 

• Tripod for stable setup 

• Calibration panels (different sizes) for multiple scan volumes 

• All required cables 

• Printed "Getting Started" guide 

• Standard PC (Windows XP, Vista or 7 - 32 or 64 bit) 

Requirements 

• Two available USB ports 

• Recommended: 2 GHz CPU, 1 GB RAM, 3d graphics card (e.g. NVIDIA GeForce or ATI 
Radeon) 

Source: https://ssl.david-vision-systems.de 

 

 

  

http://www.david-laserscanner.com/freeware/SLS-1/Kurzanleitung_EN_3.4_2012-07-06.pdf�
http://www.david-laserscanner.com/freeware/SLS-1/Kurzanleitung_DE_3.4_2012-07-06.pdf�
http://www.david-laserscanner.com/wiki/david3_user_manual/overview�
http://www.sketchup-ur-space.com/2013/march/www.david-laserscanner.com�
https://ssl.david-vision-systems.de/shop/product_info.php/language/en/info/p124_SL-Kit.html�
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Solid plugin for Google SketchUp 

1. Solid Check Plugin that shows you all the causes that makes your model a non solid. 

SuSolid is a fusion of 4 plugins related to Solid entities of Google SketchUp: 

2. Solid Repair Plugin that helps you to repair your model and makes it solid. 

3. Solid Intersection Check Plugin that shows you all the intersection between solids. 

4. Solid Weight Plugin that shows you the weight of the model and every singe 
component. 

On the picture sequence on the right you can see how quick you can make this model 

Source:

to 
be composed by 49 solid entities. Just try to do it manually and you will see how much 
time the SuSolid plugin can save you. 

You don't need to inspect the mistakes closely, just follow the edge colors and select the 
appropriate tool for that mistake. 

Mostly the best tool selection order is like on the mistakes counter 
(orange,red,green,yellow). 

Next,you can find the intersection mistakes,that can be very expensive if you are 
designing for production. 

And finally you can predict the weight of the product in the designing stage. 

 www.susolid.com/ 

 

  

http://sketchup.google.com/3dwarehouse/details?mid=bbbadeadc0d7e91da90ad19c2194f053&prevstart=0�
http://www.susolid.com/�
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Rendering In SketchUp 
For those of you who work in Sketchup and are new to rendering, or are confused by all 
the different rendering software packages available, a new book is coming out March 25 
that will help. Daniel Tal, landscape architect and author of Sketchup For Site Design, has 
written a new book, Rendering In Sketchup, which is now available for pre-order or as a 
digital download. 

There are now a number of rendering programs on the market for use with Sketchup, with 
a majority of them working from within Sketchup without having to exit the program. This 
can be a plus or a minus depending on how you work. Even though most of the programs 
offer free-use trial periods of their software, It can be pretty difficult and time-consuming 
to decide which is the best one for your workflow and budget. 

Daniel is an excellent teacher and has written a very thorough and detailed book on the 
process of rendering from Sketchup using a variety of software programs as well as 
explaining post-rendering work with Photoshop. While not every rendering engine is 
covered, he does go into a great amount of detail explaining not only the basics of 
rendering, but his own methods using Shaderlight, SU Podium and Twilight Render. 

The book covers workflow, hardware requirements, how to model efficiently for renders, 
use and teaching of textures and a lot more. At over 600 pages, the book is both a 
reference and a guide and can be read for pertinent chapters rather than just cover to 
cover. 

You can get more information on the book here, and you can view the videos on Daniel’s 
Youtube site here 

Here is a really good tutorial by Daniel you should watch which is based on the material 
from his book: 

http://vimeo.com/48282400 

If you want to know all of your rendering engine options, here is a list of rendering 
programs that work with or within Sketchup; ( Prices are as of March, 2013.) 

• 

From within Sketchup: 

Shaderlight 

• 

– $299 full license; timed access from $50 

Twilight Render 

• 

– $99 

V-Ray 

• 

– $800 

Bloom Unit 

• 

– free software , cloud-based, priced per render 

Caravaggio 

• 

– $295 

Indigo Renderer 

• 

– $220 

IRender nXt 

• 

– $499 

Light Up 

• 

– $189 

LumenRT 

• 

– $295 

Maxwell – $995 

http://www.amazon.com/Google-SketchUp-Site-Design-Architecture/dp/047034525X/ref=la_B0029CQZXS_1_2?ie=UTF8&qid=1363420000&sr=1-2�
http://www.amazon.com/Rendering-SketchUp-Presentation-Architecture-Landscape/dp/047064219X/ref=la_B0029CQZXS_1_1?ie=UTF8&qid=1363420100&sr=1-1�
http://www.ambit-3d.com/�
http://www.youtube.com/user/dtalspace�
http://vimeo.com/48282400�
http://www.artvps.com/index.php/products/shaderlight/what-is-shaderlight�
http://twilightrender.com/�
http://www.chaosgroup.com/en/2/vrayforsketchup.html�
http://www.bloomunit.com/en/�
http://www.caravaggio3d.com/products/render�
http://www.indigorenderer.com/�
http://www.renderplus.com/wp2/wk/Products.htm#IRender_nXt_.28nXtRender_for_SketchUp.29�
http://www.light-up.co.uk/�
http://www.lumenrt.com/�
http://www.maxwellrender.com/index.php/products/maxwell_for_sketchup�
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• Raylectron – $99 

• Render[in] 

• 

– $160 

Renditioner 

• 

– $99, Pro $199 

SU Podium 

• 

– $198 

Thea Render 

Source:

– $420 

 http://thedesignersassistant.com 

 

  

http://raylectron.com/�
http://www.renderin.com/�
http://www.imsidesign.com/Products/Renditioner/tabid/1756/Default.aspx�
http://www.suplugins.com/�
http://www.thearender.com/cms/index.php/plugins/thea-for-sketchup.html�
http://thedesignersassistant.com/2013/03/16/rendering-in-sketchup/�
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eDrawings Publisher SketchUp Google 
eDrawings for Google SketchUp provides an innovative way to share your designs. You 
can publish your SketchUp models to eDrawings files that can packed into a self-
executable (.exe). The self-executable file contains the viewer as well as the design 
data.This ensures that the recipients of such a files do not need to purchase or install any 
viewer to see the model. 

Download Free eDrawings for Google SketchUp 

• Google SketchUp version 5.0 (Free/ Professional) or Google SketchUp version 6.0 
(Free/ Professional). 

System Requirements: 

 

 

 

  

http://www.edrawingsviewer.com/ed/download.htm�
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SketchUp ur Space - The Creative Team 
 

 

Rajib Dey 
rajib@SketchUp-ur-space.com 

 
Rajib, the editor-in-chief of SketchUp ur Space magazine is the main writer. He is responsible to write the cover 
story, blog and many other columns. Along with it, he is creating a liaison between the writers and the readers. 
 
 

 

Manoj Kumar Singh 
manoj@jobs2india.com 

 
Manoj is enthusiastic helps to put the content of the SketchUp up Space magazine in the html version. Manoj is the 
html developer who beautifully creates each and every edition with care along with the PDF version. 
 

  
  
  
  
  
  

 
 

http://www.sketchup-ur-space.com/�
http://www.sketchup-ur-space.com/�
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